
Getting Started

Welcome to Camtasia Studio. 
This foldout guide will provide tips 
and tricks for getting the most out 
of Camtasia Studio. You will also 
find some overview information 
on the main processes including 
Recording, Editing, Production, and 
Distribution. We hope you enjoy 
Camtasia Studio!

Before You Record: 
Some Video Best Practices

Be Patient 
A 1-minute video can take 2 or 3 minutes to record for an experi-
enced user, while a beginner might need 30 minutes or longer to get 
it right. 

Practice, Practice, Practice 
How much and how often you practice is the key to creating  
professional videos. It takes practice to learn how to correctly move 
the cursor or open applications so they appear in the recording 
area. Also practice to get the positioning of the Recorder, browser 
window, and other applications just right. 

Create a Recording Standard 
For example, will your videos highlight the cursor? Will you highlight 
mouse clicks and what color will they be? Will you record keyboard 
sounds? Will you have a watermark? 

Clean-Up 
Camtasia Studio records anything on your screen. To ensure  
you get the best videos, clean up your browser and desktop by 
closing or removing non-essential applications, browser toolbars, 
and desktop icons. Use a plain background on your desktop,  
not busy wallpaper. 

No Pop-Ups! 
If you’re recording Web pages and don’t want the video to include 
pop-up windows, use a pop-up blocker or the browser’s built-in 
pop-up blocker to turn them off. 

Make Multiple Short Clips Using Camtasia Recorder 
In Camtasia Studio, you can join these short clips together into a 
longer video. Make sure to use the same dimensions for each clip. 
For easier editing, leave plenty of time between takes.

Watch the Mouse 
Normal mouse and cursor movements can appear jerky, hesitant, 
or too fast in the recording. To eliminate some of these problems, 
practice using the mouse around the screen in a slow, fluid motion.
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It’s Always Polite to Share

Camtasia Studio allows you to  
reach a broad audience and  
provides multiple ways to distribute 
your videos. Camtasia Studio  
Project Settings and SmartFocus  

allow you to quickly change video dimensions for  
different destinations. 

Publish a Video for Web Distribution 
Create a Flash file (SWF or FLV) for easy upload to the Web. 
Flash delivers very high-quality video at a small file size and 
plays in most Web browsers. 

CD-ROM-Ready
Produce your video in a CD-ready format that auto-runs on the 
viewer’s PC. 

Blog All About It 
Use Camtasia Studio to provide a seamless site visit to your 
users. Why take them away from the post or the blog to watch 
a video? Create an ExpressShow single-file SWF for simple 
embedding into a blog. 

Output Directly to iPod or iTunes Format 
Produce your video as an iPod video file including the correct 
dimensions and encoding. 

Navigation 
Simplify navigation for viewers—include a clickable table of  
contents (TOC). Use Camtasia Studio to create a TOC within  
a single video. To provide a TOC for a series of videos, use  
Camtasia MenuMaker or Camtasia Theater. 

Default Production Presets to Get You Going 
Camtasia Studio provides several default presets and  
dimensions for several commonly-viewed video formats.

Getting Great Audio: 
8 Tips for Success 

1. Use a USB Microphone 
These provide better sound, use fewer computer resources, and  
record far better audio than an analog microphone connected to 
your computer’s audio card. 

2. Practice Using a Microphone 
Experiment with different volume levels and placement. Six inches 
from the microphone is usually good to record full tones but not so 
close that other noises interfere. 

3. Record in a Quiet Location 
Any microphone can pick up nearby noises. Most office areas have 
a lot of background noise that you may not notice. Take a second 
and listen. What do you hear? 

4. Block the Computer’s Humming Sound 
Build a small box lined with foam to put your microphone in as you 
record, use pillows or blankets to muffle the noise, or cover your 
head with the blanket (this actually works very well). 

5. Use a Script 
A script helps you produce the best sounding audio by allowing 
you to avoid mistakes or saying “um” or “uh”. If you do not want a 
formal presentation, an outline can help reduce some mistakes. 

6. Project and Enunciate 
This helps your voice recording sound clear and crisp on replay. 
Imagine that you are addressing a small audience in a large room. 

7. Monitor the Audio Level as You Record 
	 The green to yellow range indicates normal. Orange 		
	 to red warns you are close to over-modulated input. Best  
	 sound quality occurs when audio level bar is kept in the  
	 green to very light orange range. 

8. Use the Audio Enhancements Option 
Audio Enhancements allow you to enhance the audio tracks by 
evening out volume levels and removing noise. 
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Preset Dimensions (in pixels) File Type

Web 640x480 ExpressShow (Single SWF)

CD 800x600 AVI

Blog 400x300 ExpressShow (Single SWF)

iPod 320x240 M4V
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But Wait...There’s More!  
Two Exciting Options

TechSmith ExpressShow 
ExpressShow creates a single SWF file that contains the record-
ing and all customizable information such as logo placement, 
table of contents, and more. ExpressShow works best for 
recordings viewed on the Web, approximately 30 minutes or less 
in length, without a great deal of motion. 

ExpressShow Capabilities 
4	 Customize the new glassy interface in multiple places. 
4	 Produce a single SWF output for easy upload. 
4	 Automatically include an additional iPod or .MP3 file  
	 for download. Size and personalize the new About box. 
4	 Use a floating or minimized table of contents. 
4	 Loop to a specific frame at the conclusion of the video. 

Access the ExpressShow Production Options 
1. In Camtasia Studio, click File > Produce Video As. 
2. Select Custom Production. Click Next. 
3. Select Flash. Click Next. 
4. Select ExpressShow with or without a table of contents (TOC). 
5. Click the Flash Options button. 

Upload to Screencast.com 
Camtasia Studio provides a fully functional hosting space for 
your videos. Screencast.com provides built-in RSS and iTunes 
functionality, so you can deliver videos directly to your viewer’s 
desktop or portable media player. 

With seamless integration between Camtasia Studio and 
Screencast.com, sharing your videos, screencasts, and more is 
just a click away. At the end of the Production Wizard or from 
the Camtasia Studio File menu, you can choose to upload your 
videos to Screencast.com. 
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TechSmith, Camtasia, Camtasia Studio, DubIt, 
EnSharpen, Morae, and SnagIt are all regis-
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What Video File Format  
Should I Use?

TechSmith ExpressShow (Single Flash SWF) 
If you have: Screen recording with low-motion screen capture 
content like PowerPoint, Web demos, and software demos. No 
Picture-in-Picture (PIP), animation, or transitions. 
Where it shines: Custom branding. Condense rich presentations 
into a single file. Ideal for Web distribution. 
What you get: A video compatible for viewing on different browsers 
and operating systems. 

Adobe® Flash FLV
If you have: Screen recording with PIP, full-motion video, camera 
video, or lots of motion on the screen. 
Where it shines: Smaller file size than SWF. Retains the highest 
quality. You can edit in other video editing programs. Ideal for Web 
distribution. 
What you get: The production process also creates an HTML file 
that references the produced FLV file. To properly play the movie 
file, launch the HTML file in a Web browser. 

iPod® / iTunes® (M4V)
If you have: Any screen recording. For best results use  
SmartFocus. 
Where it shines: Camtasia Studio automatically formats the video 
to ensure you get the correct dimension and encoding. 
What you get: A Quicktime (M4V) video specially formatted to play 
on an iPod or in iTunes. 

Windows Media® Video (WMV) 
If you have: Longer screen recording with higher motion. 
Where it shines: Produces very small file sizes even if the videos 
contain real-world photography, dithering or gradient fills. Good for 
Web delivery. 
What you get: Videos that play in Microsoft’s Windows Media 
Player – either streaming or locally from the hard disk. 

AVI 
If you have: Screen recording large in size, high motion, PIP, anima-
tion, camera video, or transitions.
Where it shines: Highest quality video possible. You can edit in 
other video editing programs. View from CD, DVD, hard drive, or 
network. 
What you get: AVI file ready to use with DVD authoring software.
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Camtasia SmartFocus Tips
 

SmartFocus allows you to quickly change video dimen-
sions for different destinations. Available in the editing 
process, SmartFocus automatically generates zoom-n-
pan key frames to optimize viewing at any dimension. 

SmartFocus collects data about the actions completed 
and the cursor movement in the recording. SmartFocus 
predicts where to add zoom effects, saving you time to 
manually find and insert all the frames to zoom or pan. 

Recording Tips For SmartFocus 

Record at full screen, produce at a smaller dimension. 
For example, record a full screen application and produce the final 
video for distribution on the iPod. 

Hover the mouse cursor where you want the viewer to look. 
Keep your mouse cursor still on the area of focus in the recording. 
For example, if you want the viewer to see a hyperlink, place the 
mouse cursor on or near that area as you speak and then click. 

Do not “talk” with the mouse cursor. 
Do not move the mouse cursor across the screen as you speak.  
Try to keep the mouse cursor in the area of focus in the recording. 

Keep the mouse cursor close when entering text. 
If you want the viewer to see what you type into the text box,  
keep the mouse cursor in the text box. 

Use the mouse scroll wheel (if applicable). 
Try using the mouse scroll wheel instead of clicking and dragging 
on the scroll bar. SmartFocus may zoom in on the scroll bar instead 
of showing the content being scrolled. 

Record clips longer than 30 seconds.
SmartFocus is optimized for recordings longer than 30 seconds.  
For shorter clips, you can manually add zoom-n-pan key frames. 

Slow down.  
Use slow, deliberate mouse movements. Do not click around the 
screen too fast.

Record a PowerPoint
Presentation

4 	Best Font: 32 Arial 
4	 Use Sans Serif Fonts 
4	 Use High Contrasts: 
	 * Light background  
	   with dark font 
	 * Dark background with  
	   light font 
4	 Use Simple Backgrounds 
4	 Spell Check Before Recording 
4	Use the Notes Option 
	 Notes import into Camtasia  
	 Studio as captions. 

4	Use Title Placeholders 
	 Text will import into Camtasia  
	 Studio as Table of  
	 Contents Markers. 
4	Use Well-Cropped Images 
4	Use Simple Animations 
4	Transitions Between Slides 
	 * Add them in PowerPoint  
	   not Camtasia Studio. 
	 * Use the same transition  
	   throughout the entire  
       presentation.

1.    	 In Camtasia Studio Task  
  	 List, choose Record PowerPoint. 

2.    Open a PowerPoint presentation to record. The recording   
  toolbar appears (In Office 2007, in the Add-Ins tab): 

3.    To record narration, click Record Audio. 
4.    To record camera video (Picture-in-Picture), click Record Camera.
5.    To preview the camera stream as you record, click  

  Camera Preview. 
6.    To begin the recording, click Record. The slide show appears  

  with the recording in paused mode. 
7.    Click the Click to begin recording button in the lower right-hand  

  corner. If you are recording the camera, the camera initialization  
  dialog will show momentarily. 

8.    The recording begins immediately. Move through the  
  PowerPoint presentation slides as you normally would. 

9.    At the end of the presentation, press the Esc key to end  
  the recording. 

10.  A prompt asking to stop recording or continue appears. Click  
  Stop recording. 

11.  A prompt to save your work as a Camtasia Studio recording file  
  (CAMREC) appears. You can make changes later, during editing. 

12.  Name this project and click Save. 

PowerPoint Presentation Creation Tips 
Use these PowerPoint best practices to get the  
very best results when recording and sharing  
your presentation. 
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Record with a Preset Size 
1. From the Welcome screen click New Screen Recording.  
    -or- in Camtasia Studio, click Make a Recording. 

2. Choose Audio options. 

3. Choose Camera options. 

4. Click the Select Area to Record button or press <F9>. 

5. Choose the entire desktop. When you hover over the  
    desktop border, a border appears around  
    your whole monitor. 

6. The Camtasia Recorder Selection Area options appear.  
    Click the Record button or press <F9> to begin recording. 

Select an Area to Record 
		  When you click the Select Area to Record button 	
		  you have three choices for selecting the area  
		  to record: 

Full Screen select: Click your desktop. When you hover over it, 
a border appears around your whole monitor. 
Window select: Hover over any window, and the area that will be  
recorded is highlighted in red. 
Region select: Drag the cursor anywhere to select a region for recording. 

Recording Resizing Tips 
			   To maintain the aspect ratio of the  
			   recording area as you resize it,  
			   click Lock icon. 

Before resizing windows or applications, check the Lock to application 
option to lock the recording area to the active window. As you resize the 
recording area, the window or application also resizes. 

To move the position of the recording area on the screen, click inside 
recording area and drag it to a new location on the screen. 

Recording How To’s
Camtasia Recorder captures cursor movements, menu selections, pop-up windows, layered windows, typing, and other items you 
see on the screen. Choose to record applications, your computer’s desktop, Web sites, and much more. Camtasia Recorder saves 
the screen recordings as Camtasia Studio recording files (.CAMREC) or as Audio Video Interleave files (.avi) to import into a  
Camtasia Studio project file (.CAMPROJ) for editing and production. 

Save a Recording 
1. First Stop the recording. The Camtasia  
    Recorder Preview appears. Click Save. 
2. The Save Recording dialog box appears.  

Enter a File name and location.
3. Click Save. The Post-Save Options  
    dialog box appears. 
4. Select an option and click OK. 

Edit my recording: The recording file appears in the Clip Bin and the 
Timeline in Camtasia Studio, ready for you to edit.
 
Produce my video in a shareable format: Opens the Production  
Wizard in Camtasia Studio to produce the recording file into  
a shareable format. 

Create another recording: Opens Camtasia Recorder to create  
a recording. 

The Recording Toolbar
The Recording toolbar appears below the recording window  
during a recording. 

Option Hot Key

Record <F9>

Stop Recording <F10>

Add Marker <CTRL + SHIFT + M>

Screen Draw <CTRL + SHIFT + D>

Recorder provides several  
toolbars. Enable a toolbar  
from the View menu. 

Adjust Audio Volume 

Elapsed Time 

Annotation Tools 

Zoom and Pan Tools

Cursor and Click Tools 

ScreenDraw Tool
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A. Main Toolbar
	
	 New Project 		  Import Media 

	 Open Project 		  Produce

	 Save Project 		  Undo/Redo

B. Clip Bin 
Media files are stored here for easy access. Drag a clip from the 
Clip Bin to the Timeline to include it in the video. When you save the 
project, you also save all clips within the Clip Bin. 

C. Clip Bin Views 
You can use several different views to organize the clips. By default, 
the Clip Bin view is Thumbnails Shown in Groups. Right-click on 
any background white space, and choose another view or sorting 
order from the context menu. 

D. Task List 
Begin most tasks by selecting an option in the Task List. To access 
any task, click on a task with the mouse cursor. The properties page 
appears. 

E. Preview Area 
Double-click on clips within the Clip Bin to view before you add 
them to the Timeline. 

As you move through the video on the Timeline, the Preview Area 
keeps pace with the seek bar, displaying the current frame.

As you add Voice Narration, the clips on the Timeline play in the 
Preview Area so you can narrate in real time for perfectly synched 
audio.

When editing Callouts in the Callouts Properties task pane, make 
size and position adjustments directly inside the Preview Area. The 
Preview Window shows how your final video will look produced at 
that size.

Camtasia Studio Overview and Basic Tasks

F. Playback Control Toolbar 
Use the Playback Control toolbar to move throughout the clips in 
the Clip Bin and the video on the Timeline or Storyboard.

The Time Status bar lets you know exactly where the seek bar is 
on the Timeline in the context of the entire video laid out on the 
Timeline. 

G. Timeline 
Use to assemble screen recordings, still images, audio files, Call-
outs, Title Clips, Markers, and other forms of media. 

Collectively, the media files placed on the Timeline are called Clips. 
On the Timeline, control the timing of each clip, add or remove 
clips, edit frames, add sound and more.

When you first begin to work with Camtasia Studio, you are in Timeline view. Several components reside within the Timeline view 
including the Task List, Timeline, Task Area, and Preview Area. 

A. B. E.

C.

D.

F.

G.

The Project Settings define the editing  
dimensions and resizing options for your video
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Add a Callout 
Click Callouts in the Task List. 
Within the Callouts Manager task 
page, click the Add Callout link. 
The Callout Properties task page 
appears. Select the Callout shape, 
choose color, add text, apply the 
behavior properties. Click Finished! 

Add a Blur Callout 
Blur Callouts mask or hide confi-
dential or sensitive information that 
might be in a screen recording. Add 
a blur the same way that you add a 
Callout. When selecting the shape, 
choose Blur Callout. 

Add a Custom Callout 
You can add a custom Callout by 
importing your own graphic. In the 
Callout Properties task page click 
the Custom Callouts button. Click 
the New Custom Callout button. 
Find the image and click Open. 
Apply any properties and click OK. 
The new callout is added to the 
last position in the Callout Type 
dropdown list.

Callouts 
Add a Callout to the Timeline so when the video is produced, 
the image appears within the video. Callouts are graphics that 
come in different shapes and styles. You can customize a  
Callout’s color, font, opacity, size, text, and more. 

Use a Title Clips to add a 
Graphic and/or Text: 
•  Before a clip on the Timeline to 

act as a title. 
•  Between clips on the Timeline to 

function as a chapter heading. 
•  At the end of the video to feature 

your credits or other information. 

Create a Title Clip 
Choose the Title Clips link in  
the Task Pane. The Title Clips  
Properties task page appears.  
As you create the Title Clip,  
the Preview Area updates  
with the changes. 

A Title Clip appears in the Clip Bin 
after creation. Drag the Title Clip 
down to the Timeline to include in 
the video. 

Create a Custom Title Clip 
To use an existing image as the 
background for a Title Clip: In the 
Title Clips Properties task page, 
click the Browse button in the 
Background group box. 
Find any BMP, GIF, JPG, or PNG 
image file. Click Open to update 
the image file to the Title Clips  
task page. 

You can right-click on a Title Clip  
to edit it within the Clip Bin.  
From the context menu, choose 
Edit Title Clip. 

Important: Edits made to Title 
Clips within the Clip Bin do not 
update any instances of that Title 
Clip already on the Timeline.

Script or No Script? 
If you don’t want viewers to hear unnatural pauses, occasional 
stutters, and mispronunciations, you may need a script. 

Flash HotSpots
Flash HotSpots add Flash interactivity to a Callout within a  
produced Flash movie.

Use a Flash HotSpot to make chapters in the video or to take the viewer to 
a Web site after they finish watching the video. 

Adding a Flash HotSpot
In the Callout Properties task page, add the desired Callout to the Timeline. 
Enable Make Flash HotSpot option. Click Flash HotSpot Properties  
button. Apply the HotSpot properties and click OK. 

Recording with a Script 
When using a script, record the 
screen first (without the audio) 
using the script as a guide. Edit 
the video in Camtasia Studio while 
reading the script out loud until the 
vocal timing seems right. Then, 
record the audio as a separate WAV 
file using Camtasia Audio Editor as 
the video plays along in Camtasia 
Studio. Import the final WAV file into 
Camtasia Studio and place on the 
Timeline. The two files will sync up. 

Scripting Tips 
1. Think through the actions to 

capture, and write them down in 
sequential steps. 

2. The script should contain the 
exact words to record. Avoid us-
ing repetitive phrases or words, 
long pauses, or hesitations in the 
narration. 

3. Include an overview of the 
recording in the first line or two of 
the script. 

4. Print the script in large type 
to make it easy to read while 
recording. 

5. To eliminate the sound of paper 
shuffling, tape the script pages 
together and hang them near the 
monitor so they are easy to read.

Title Clips 

Tip A. Callouts with 
a HotSpot are only 
available with Flash 
output. No other video 
file format can use  
this feature.

Tip B: Wait until you 
have completed all of 
the edits before add-
ing the Callouts with  
a HotSpot. 

Tip C: You must 
produce your video 
to see and test the 
HotSpots. 

Option Description

Pause at end of Callout The viewer must take some action in order to continue viewing the movie

Click to Continue The viewer must click the Callout with Hotspot on the screen to continue watching 
the video

Go to frame at time The viewer will be taken to a specific frame within the video

Go to Marker The viewer will be taken to a specific Marker within the video

Jump to URL The viewer will be jumped to a particular URL address
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Timeline Editing Tips
Use the Timeline to make basic edits to the video and image clips. You can remove unwanted mistakes in the recording, shorten or 
lengthen clips to accommodate audio, etc. Original files or clips in the Clip Bin are not affected by your edits on the Timeline.

A. Make a Cut 
Cutting deletes unwanted portions of the clip(s) from the Timeline. 
1. Lock any track(s) that contain clips and elements that you do not 

want to cut. 
2. Select the range of time to cut by clicking and dragging the seek 

bar on the Timeline. 
3. Click Cut Selection. 

B. Make a Split 
Splitting a clip divides one clip into two smaller clips making it  
easy to insert Transitions or graphics between scenes. All clips  
and elements located at the position of the seek bar are split  
unless you lock the tracks you do not want to split. 

C. Add Markers 
Markers provide easy navigation points for your viewer. When you 
produce the video with a Table of Contents, the Markers appear as 
hyperlinks. 
1. On the Timeline, place the seek bar on the frame where you want   
    to add a Marker. 
2. Press <CTRL + M> on the keyboard. 

D. Make a Selection for Editing 
Before you can make most edits to a clip on the Timeline, you must 
select the area to edit. 
1. Click down and hold the mouse cursor at the point where you 

want to begin the selection. 
2. With the mouse cursor still held down, drag the seek bar across 

the Timeline. 

E. Adjust the Volume on the Timeline 
Click Audio Up or Audio Down to adjust the audio wave form for the 
entire Timeline. Continue to click for desired effect. 
Audio Fades: Highlight a section of the Timeline. Click Fade In or 
Fade Out. 

Additional Timeline Tips
Lock and Unlock Tracks 
When applying edits to a Timeline selection, the edits are applied 
to all clips and elements located across all tracks, unless you lock 
specific tracks. 
 
• Click the Unlock icon on the Timeline track that you want to lock. 
• Click the Locked icon on the Timeline track that you want to unlock. 

Did you know that the audio in the project can be saved as one  
separate but combined audio file? 
Use this feature to backup the audio track or, use the sound track in 
a different application. 
1. Choose File > Save Audio As. 
2. Choose either MP3 or WAV. 

Don’t Like the Audio in Your Recording? 
Replace it! Make a Timeline selection and click the Replace with 
Silence button. Then, add a voice narration recording to replace  
the old audio. 

See Close-Up!
Use the Zoom In and Zoom Out buttons to get a better view of the 
Timeline. 

A. B.

C.

E. D.

Option Hot Key Option Hot Key Hot Key Hot Key

Play/Pause Spacebar Select from current 
point to beginning 
of Timeline

CTRL + SHIFT 
+ END

Step Forward CTRL + Left 
Arrow

Zoom In 
Zoom Out

CTRL + Plus
CTRL + Minus

Select from current 
point to end of 
Timeline

CTRL + SHIFT 
+ HOME

Step Backward CTRL + 
Right Arrow
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